
 

 

 

 

 

 

 

 

 

 

 

 

2014 Knowledge-Based Compilations and Reviews is designed to help the accountant efficiently and effectively perform 
financial statement compilations and reviews of nonpublic commercial entities in accordance with Statements on Standards for 
Accounting and Review Services (SSARS) issued by the Accounting and Review Services Committee (ARSC) of the American 
Institute of Certified Public Accountants (AICPA). 
 
The Knowledge-Based Compilation and Review (KBCR) Methodology emphasizes using knowledge of the entity to perform 
compilation and review engagements by facilitating the flow of information so that the understanding obtained in each process affects the 
decisions made in the next. Although the accountant will likely perform most steps in this methodology sequentially, conducting an 
engagement is not necessarily a linear process. Knowledge gained from preliminary engagement activities helps the accountant design and 
customize engagement procedures; evidence gained from procedures performed is evaluated and the appropriate accountant’s report is issued. 
This edition includes specific up-to-date guidance for conducting compilation and review engagements in accordance with the 
SSARS. This document is published for the purpose of communicating, to users of the toolset, updates and enhancements included 
in the current version. This document is not, and should not be used as, a program to update the engagement documentation of an 
engagement started in a previous version of this product. 
 
This is the fourth update to this Knowledge Coach title. If you are updating from a previous version of this title, refer to the 
Knowledge Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.  
 
For more information on the Knowledge-Based Methodology and how it works within ProSystem fx® Knowledge Coach, refer to the 

Additional Information section in this bulletin. 

 

WORKPAPER NOTES 

Important Note for Customers updating binders from 2010, 2011, 2012, or 2013 Knowledge Based Compilations and Review 

You must install 7.0 with and Knowledge Coach v 2.0 March 2014 Update (including 2013 Tax Grouping Update) or higher  before 
installing the 2014 Knowledge Based Compilations and 2014 Knowledge Based Reviews titles. For more information on 
Engagement 7.0 and Knowledge Coach 2.0, review the Release Notes and associated Knowledge Base article at the following link: 
http://support.cch.com/updates/KnowledgeCoach/.  
 
General Roll Forward Note 

You must be the current editor of all Knowledge Coach workpapers to update to the latest content during roll forward, and you 
must be the current editor upon opening the updated workpaper for the first time to ensure you see the updated workpaper. 
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Welcome to the latest version of 2014 Knowledge-Based Compilations and Reviews (8/13/14), 
the latest title available in the ProSystem fx® Knowledge Coach series!  

 

Please review this bulletin prior to installation and use. If you have any questions, call Technical 

Support at 1-800-PFX-9998, option 4.  

http://support.cch.com/updates/KnowledgeCoach/


The 2014 Knowledge-Based Compilations and Reviews Tools have been updated to take into account the latest literature, 
standards, and guidance applicable to compilation and review engagements. The 2014 tools include links to detailed analysis related 
to the steps and processes discussed in the workpapers. Also included is a revised financial statement disclosures checklist that 
provides a centralized resource of the required and recommended U.S. GAAP disclosures and key presentation items currently in 
effect, using the style referencing under the FASB Accounting Standards Codification.™  

The 2014 Edition of Knowledge-Based Compilations and Reviews is current through Statement on Standards for Accounting 
and Review Services No. 20 (SSARS-20), Revised Applicability of Statements on Standards for Accounting and Review Services, AR Section 
9080, Compilation of Financial Statements-Accounting and Review Services Interpretations of Section 80, and AR Section 9090, Review of Financial 
Statements-Accounting and Review Services Interpretations of Section 90. Users of this content should consider guidance issued subsequent to 
these items to determine their effect on engagements covered by this product. 
 
Specific Program Enhancements 

 

The 2014 Knowledge-Based Compilations and Reviews include the following features: 

 RPT-0900 Reporting Tool to assist the accountant in selecting the correct report. 

 Eliminated duplication of steps where possible 
 

For more information on specific program enhancements, review the 2014 Compilations and Reviews Overview for Knowledge 
Coach users available at the following link or in the binder through the KCO-001 workpaper. 
https://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2014%20Comp%20Rev%20Title%20Overview%20for%20K
nowledge%20Coach%20Users.pdf 
 

In addition, forms and practice aids throughout have been updated, where applicable, to take into account: 

 Statement on Standards for Accounting and Review Services No. 20 (SSARS-20), Revised Applicability of Statements on 
Standards for Accounting and Review Services;  

 AR Section 9080, Compilation of Financial Statements-Accounting and Review Services Interpretations of Section 80;  

 AR Section 9090, Review of Financial Statements-Accounting and Review Services Interpretations of Section 90; and 

 AICPA Statement on Quality Control Standards No. 8 (SQCS-8), A Firm's System of Quality Control (Redrafted). 

 
Users of this content should consider guidance issued subsequent to these items to determine their effect on engagements covered 
by this product 
  

https://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2014%20Comp%20Rev%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
https://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2014%20Comp%20Rev%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf


Additional Information on Knowledge Coach and the KBA Methodology 

The key components of the KBCR methodology include: 

 An Overview that guides accountants through the KBCR methodology; 

 Compilation Programs and Review Programs that take accountants through related steps and procedures designed for 
use in compilation and review engagements; 

 Practice Aids to help accountants complete steps or processes outlined in other related documents and provide example 
financial statement formats for different types of entities;  

 Reports that provide a variety of sample accountant’s reports on compiled or reviewed financial statements; 

 Correspondence documents that provide sample engagement letters and management representation letters to be used in 
many common situations; and 

 Knowledge-Based Compilation and Review documents, integral to the overall engagement process, that contain steps 
and procedures required by SSARSs. 

 

The AICPA’s Accounting and Review Services Committee (ARSC) SSARS - The practice aids and tools in the 2014 Edition 
of Knowledge-Based Compilations and Reviews are designed around the AICPA’s SSARS standards to assist accountants by: 

 Facilitating compliance with the SSARS;  

 Encouraging more effective engagements through tailored engagement programs and comprehensive practice aids; and 

 Enhancing engagement documentation. 
 

ProSystem fx® Knowledge Coach 

ProSystem fx® Knowledge Coach functionality allows accountants to use the Knowledge-Based methodology more efficiently by 

eliminating the need for duplicate entry of the same information, tailoring documentation to each particular engagement, and 
documenting procedures performed. CMP-100 Tailoring Question Workpaper or REV-100 Tailoring Question Workpaper are documents 

in Knowledge Coach that presents engagement-level questions designed to aid in tailoring the engagement documentation to fit each 
client. Completing the questions helps the accountant avoid duplication and unnecessary workpapers.  

Before you begin your engagement, please review the guidance in CMP-101 Overall Compilation Program or REV-101 Overall Review 

Program. These workpapers are intended to be your road map through the Knowledge-Based methodology. You should start your 

engagement with CMP-100 Tailoring Question Workpaper or REV-100 Tailoring Question Workpaper and CMP-101 Overall Compilation 

Program or REV-101 Overall Review . 

The Risk Assessment features have been disabled since the  2012 Knowledge-Based Compilations and Review Title for Knowledge 
Coach. Refer to KBC-101 Compilation: Significant Matters and KBR-102 Review: Significant Matters to accumulate and review 

significant issues and findings. CMP-801 Compilation Program: Significant Risks and Uncertainties and REV-802 Review Program: 

Significant Risks and Uncertainties provides a guide for implementing the guidance related to the disclosure of certain significant risks 

and uncertainties. 

Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent 

information ensures that information and updates to information are not missed between workpapers. Drill-down functionality 
helps the user navigate quickly to the source of the information, aiding in the review of the engagement file. 

Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks or 

relevant assertions, missing workpaper, and more.  

Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes compilation and review content, you 

can link directly to source material from Resources within Knowledge Coach documents. These links have been updated to 
reference to the accounting standards under the FASB Accounting Standards Codifications. Also, if you subscribe to the Knowledge-
Based Compilation and Review Guide on ARM, you can take advantage of links to the guide material from within the Knowledge Coach 
documents. 

Interpretive Guidance is integrated into each Knowledge Coach through the Tips view of each new task pane. Informational features 

include Practice Points, Examples, Optional Workpapers, and Resources to help accountants work more effectively and efficiently. 
We have also added the ability to navigate from Resources within a document or the tip pane directly to CCH’s Accounting 
Research Manager and industry audit guides by simply clicking on the Reference. 



Important Notes 

 Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated. 

 If your Current Editor Knowledge Coach MS Word workpapers become read-only or crash, please do the following: 
o Keep the binder with the affected workpapers open. 
o Highlight the workpaper in the binder window and go to Tools>Save Knowledge Coach Answers. 

 Knowledge Coach cannot be used within the Shared File Room (SFR) feature of Engagement. However, Knowledge Coach 
workpapers can be shared across team members through check in, check out, workpaper assignment, syncing to the central 
file room and through peer-to-peer sync in the same way other Engagement workpapers are shared. 

System Requirements 

 This title MUST be used with ProSystem fx Engagement version 7.0 and Knowledge Coach v 2.0 March 2014 Update 
(including 2013 Tax Grouping Update) or higher. If you are upgrading from ProSystem fx Engagement 6.0, 6.1, 6.1.2, 6.5, 
6.8, or 6.11 please contact Technical Support at 1-800-PFX-9998, option 4 for detailed instructions 

 A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx 
Knowledge Coach workpapers. 

Download Instructions 

Download the 2014 Knowledge-Based Compilations and/or 2014 Knowledge-Based Reviews from the ProSystem fx Knowledge Coach 
Updates section of the ProSystem fx Engagement Support Web site at the following URL: 
http://support.cch.com/updates/KnowledgeCoach, then select the Knowledge Coach Series and Download file link next to the 
2014 Knowledge-Based Compilations and/or the 2014 Knowledge-Based Reviews titles. On some occasions the content 
package file (.KCP) has downloaded with the extension changed to .ZIP. If this occurs, please change the extension of the 
downloaded file to KCP using all capital letters. 
 
You must install the Financial Statement Base title (3-7-2014) before installing the 2014 Knowledge-Based Compilations and 2014 
Knowledge-Based Reviews.  The Financial Statement Base title is also available at the following link: 
http://support.cch.com/updates/KnowledgeCoach    
If you have already installed this title for 2013 Knowledge-Based Audits of Commercial Entities, you do not have to reinstall. 
 
Important: ProSystem fx Engagement version 7.0 or higher must be installed on the computer in order to install this Knowledge 
Coach title. Additional requirements include Microsoft Office 2007, Microsoft Office 2007 Primary Interop Assemblies (PIA), 
Visual Studio 2005 Tools for Office Second Edition Runtime, Visual Studio Tools for Office System Runtime version 3.0, Visual 
Studio Tools for Office System 3.0 Runtime Service Pack 1, Visual Studio Tools for Office Runtime 4.0 (VSTOR) (32-bit version 
for 32-bit OS and 64-bit version for 64-bit OS). 
 
The following 2014 Knowledge-Based Compilations and Reviews (8/13/14).KCP download is a proprietary file that must be 
installed from within Engagement. Save this KCP file to a location on your local drive and follow the Installation Instructions 
included in the Release Bulletin. 

Installation Instructions 

Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx 
Engagement. The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach program 
content files. Please refer to the ProSystem fx Engagement with Knowledge Coach Release Notes for any other system 
requirements.  
 
 
 
 
 
 
 

http://support.cch.com/updates/KnowledgeCoach
http://support.cch.com/updates/KnowledgeCoach


 
 
 
 
 
 
After downloading the 2014 Knowledge-Based Compilations and Reviews titles, do the following: 
 

1. Launch the ProSystem fx Engagement Workpaper Management application so that the Local File Room is 
displayed. Select Tools > Knowledge Coach Titles.  

 The Knowledge Coach Titles window will be displayed.  
2. Choose Add Title.  
3. Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx Knowledge Coach 

Support Web site.  
4. Choose Open.  
 The system will display a progress indicator while the title package is added. You will receive a message that the 
 title has been successfully installed once the process is complete. 

 
Once the title is added, you must release it, so that other staff members in your firm can use it. You may also wish to “unrelease” 
previous versions of the title. 
 
To unrelease a title: 
 

1. Select a version of the KBA Compilation and Review title. 
2. Choose Unrelease Title. The date will be removed from the Date released column and staff that do not have the 

staff group property right to insert unreleased titles will not be able to insert the unreleased titles into a binder.   
 
Note: You can determine this access in the ProSystem fx Engagement Admin module by selecting a staff group and 
choosing File > Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option. 

 
To release a title:  
 

1. Select one of the Knowledge Coach titles in the list that has been added but is not yet released.  
2. Choose Release Title. The current date and time will be displayed in the Date released column, and the status will 

change to “Released.”  
Note: You must add and assign a Knowledge Coach module as well as the Knowledge Coach title license in the  
ProSystem fx Engagement Administrator before using the workpapers.  

Important: Once the 2014 Knowledge-Based Compilation and Reviews titles have been added and released, they will be 
automatically deployed to other staff members when they login to the “Office” location, or when they synchronize a binder 
that contains Knowledge Coach workpapers from this title.  

Online Permission Key 

Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx    
or when adding or updating the new licenses within ProSystem fx Engagement with Knowledge Coach version 7.0 and higher. After 
updating the license file in the ProSystem fx Engagement Admin module, licenses need to be assigned to the staff who will use 2014 
Knowledge-Based Compilations and Reviews. 
 
If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.  

Permission keys are no longer generally distributed via floppy diskette. You can choose to continue receiving the diskette by going to 

https://prosystemfxsupport.tax.cchgroup.com/service/accountadmin/ , clicking the Firm Administration link, and making the 
appropriate selection (SSO access is required), or by contacting Customer Service at 1-800-PFX-9998, option 1. 

https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
https://prosystemfxsupport.tax.cchgroup.com/service/accountadmin/


Figure 1 – New Knowledge Coach Workpaper 

 

 

 

 

 

Accounting Research Manager 

CCH’s Accounting Research Manager is the most comprehensive, up-to-date and objective online database of financial reporting 
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written 
interpretive guidance.  

Our Weekly Summary email newsletter highlights the key developments of the week, giving you assurance that you have the most 
current information. It provides links to new FASB, AICPA, SEC, EITF, and IASB authoritative and proposal-stage literature, plus 
guidance from financial reporting experts.  

Our team of content experts updates the system on a daily basis, so you can stay as current as possible. What’s more, our experts 
attend critical, standard-setting meetings and summarize the results for you, which means you’ll learn of newly released literature and 
deliberations of current financial reporting projects as soon as they occur! Plus, you’ll benefit from their easy-to-understand technical 
translations. Our expert’s interpretations clearly lay out what the rules mean from your perspective.  

Also available is the Knowledge-Based Compilations and Reviews, a guide that helps you comply with the most recent professional 
standards and guidance for the conduct of compilations and reviews and to integrate the use of practice aids, tools, and other 
resources with its guidance. This publication supplements and complements the Knowledge-Based documents that are available in 
Knowledge Coach. 

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more 
about our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. 
You can also access the Accounting Research Manager Web site by selecting the item in ProSystem fx Engagement from the 
Guidance tab on the Shortcuts bar in the Binder window.  
 

Links to Accounting Research Manager (ARM)  

As indicated above, subscribers to an Accounting Research Manager library that includes source content can link directly to source 
material from references within Knowledge Coach workpapers. These links have been updated to reference the new Codification 
released by the FASB and available on ARM. The Codification on ARM is fully integrated with U.S. and international accounting 
standards, other non-authoritative materials and industry leading interpretive guidance.  

 

Using Your Knowledge Coach Content 

To use your Knowledge Coach Workpaper Templates, open a 
binder in ProSystem fx Engagement, select the workpaper tab 
into which you would like to insert the workpaper, and select 
New Knowledge Coach Workpaper from the toolbar or 
File menu. The New Knowledge Coach Workpaper dialog 
appears (Figure 1). 

Select the New Knowledge Coach Title with the content 
you would like to use. You can only select titles you have 
installed. The information displayed changes to reflect the 
workpaper organization available for the selected title. 
Select the Knowledge Coach Workpaper Templates to 

http://www.accountingresearchmanager.com/


8490 

insert into your binder and click OK. The Selected Workpaper Properties dialog appears. Each workpaper name is automatically 
loaded into the Name field. Add a workpaper index in the Index field and make any Name modifications you desire. You can also 
modify the tab location or the roll forward settings for each workpaper. Then click OK. The integrated Knowledge Coach 
workpaper is now inserted into your engagement binder. For more information on how to use Knowledge Coach workpapers in 
your binder, see the Knowledge Coach User Guide.  

 

Download 
Description: 

2014 Knowledge-Based Compilations and Reviews 
(8/13/14) 

Version: 
ProSystem fx Engagement version 7.0 with and Knowledge 
Coach v 2.0 March 2014 Update (including 2013 Tax 
Grouping Update) or higher 

Release Date: August 2014 

File size: 18MB 

Approx. 
Download Time: 

42 minutes at 56 kbps 

License: Full Version 

Platforms: Windows XP/Vista 7, 8 and 8.1 

Office: Microsoft Office 2007 required 

 Contact Information 

For a demo or to purchase additional titles as they become available 1-800-PFX-9998, option 1 
Technical Support 1-800-PFX-9998, option 4, then option 1 

The ProSystem fx Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by 
CCH, a Wolters Kluwer business. The contact information above can be used for customer service and support issues for this 
product. For information about other CCH products, please call 1-800-248-3248 or visit the online Store at 
http://tax.cchgroup.com. 
 


